
Shelley Fishel

Excel 2013 Core: Advanced

Download free books at



Download free eBooks at bookboon.com

2 

 

Shelley Fishel

Excel 2013 Core  
Advanced

http://bookboon.com/


Download free eBooks at bookboon.com

3 

 

Excel 2013 Core: Advanced
1st edition
© 2014 Shelley Fishel & bookboon.com
ISBN 978-87-403-0718-4

http://bookboon.com
http://bookboon.com/


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Advanced

4 

Contents

Contents

	 About Shelley Fishel 	 10

	 About Excel 2013 Core Advanced	 11

1	� Apply Conditional Logic in formula	 12
1.1	 IF Function (IF Statement)	 12
1.2	 Nested IF Function	 14
1.3	 COUNTIF Function	 15
1.4	 SUMIF Function	 17

2	 Create and apply Range Names	 18
2.1	 Defining a Named Cell or Range of Cells	 18
2.2	 Using a Named Cell in a formula	 20
2.3	 Naming a range of cells	 22
2.4	 Editing and renaming a named range	 24
2.5	 Define a Name Using the Dialogue Box	 25
2.6	 Sum a range	 27

www.sylvania.com

We do not reinvent  
the wheel we reinvent 
light.
Fascinating lighting offers an infinite spectrum of 
possibilities: Innovative technologies and new  
markets provide both opportunities and challenges. 
An environment in which your expertise is in high 
demand. Enjoy the supportive working atmosphere 
within our global group and benefit from international 
career paths. Implement sustainable ideas in close 
cooperation with other specialists and contribute to 
influencing our future. Come and join us in reinventing 
light every day.

Light is OSRAM

http://bookboon.com/
http://bookboon.com/count/advert/ae925238-62e0-4fca-a4f2-a24b0097a136


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Advanced

5 

Contents

3	 Charts	 29
3.1	 Using Quick Analysis	 29
3.2	 Recommended Charts	 30
3.3	 Creating charts with the keyboard	 32
3.4	 Creating line charts	 34
3.5	 Creating and editing a column chart	 36
3.6	 Creating pie charts	 38
3.7	 Modifying charts using the Ribbon	 38
3.8	 Modifying charts using icons	 46
3.9	 Formatting charts – Task Pane	 48

4	� Apply and manipulate illustrations	 51
4.1	 Pictures in Excel	 51
4.2	 Resize the picture – dragging	 54
4.3	 Modify a picture	 55
4.4	 Reset a picture	 60

5	 SmartArt	 61
5.1	 SmartArt	 61

EADS unites a leading aircraft manufacturer, the world’s largest 
helicopter supplier, a global leader in space programmes and a 
worldwide leader in global security solutions and systems to form 
Europe’s largest defence and aerospace group. More than 
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter, 
in 90 locations globally, to deliver some of the industry’s most 
exciting projects.

An EADS internship offers the chance to use your theoretical 
knowledge and apply it first-hand to real situations and assignments 
during your studies. Given a high level of responsibility, plenty of 

learning and development opportunities, and all the support you need, 
you will tackle interesting challenges on state-of-the-art products.

We welcome more than 5,000 interns every year across 
disciplines ranging from engineering, IT, procurement and 
finance, to strategy, customer support, marketing and sales. 
Positions are available in France, Germany, Spain and the UK.

To find out more and apply, visit www.jobs.eads.com. You can also 
find out more on our EADS Careers Facebook page.

Internship opportunities

CHALLENGING PERSPECTIVES

http://bookboon.com/
http://bookboon.com/count/advert/85f92380-2160-4386-98b4-a2540089b583


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Advanced

6 

Contents

6	 Shapes	 65
6.1	 Inserting shapes into a workbook	 65

7	 Screenshots	 67
7.1	 Inserting a screenshot	 67

8	 Manage comments	 69
8.1	 Inserting and editing comments	 69
8.2	 Deleting comments	 71
8.3	 Show/Hide Comments	 72
8.4	 Moving between comments	 74
8.5	 Printing comments	 75

9	 Sorting data	 77
9.1	 Databases in Excel – introduction	 77
9.2	 Sort data	 78
9.3	 Sort on font colour	 84
9.4	 Sort on cell colour	 84
9.5	 Sort on cell icon	 85

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 
© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

http://bookboon.com/
http://bookboon.com/count/advert/0ba6aa54-2f19-4d35-9ee1-a00400a7e3c6


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Advanced

7 

Contents

10	 Filtering data	 87
10.1	 Filter data – the filter icon	 87
10.2	 Filter on text	 88
10.3	 Filter on more than one column	 90
10.4	 Remove the filter	 91
10.5	 Filter data on colour	 92
10.6	 Text filters	 95
10.7	 Number filters	 96
10.8	 Date filters	 99

11	 Format as table	 101
11.1	 What is format as table	 101
11.2	 Format as table icon	 101
11.3	 Insert a table	 103
11.4	 Change table style	 104
11.5	 Remove formatting	 106
11.6	 Name the table	 107
11.7	 Calculated columns	 108
11.8	 Add a total row	 110
11.9	 Convert back to a range (remove automatic functionality)	 112

We will turn your CV into 
an opportunity of a lifetime

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com

http://bookboon.com/
http://bookboon.com/count/advert/b6907fa5-6d27-49ae-a477-a01a01116857


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Advanced

8 

Contents

12	 Filter a table	 115
12.1	 Filter a table	 115
12.2	 Filter a table with a total row	 116
12.3	 Insert a slicer	 118
12.4	 Customize a slicer	 121
12.5	 Delete a slicer	 121

13	 Grouping and outlining	 122
13.1	 Outlining	 122
13.2	 Create an automatic outline	 126

14	 Subtotals	 127
14.1	 Why use subtotals?	 127
14.2	 Sort first	 128
14.3	 Subtotals command	 129
14.4	 Remove subtotals	 132

15	 Apply conditional formatting	 133
15.1	 Conditional formatting	 133
15.2	 Top and bottom rules	 135

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

www.discovermitas.com

http://bookboon.com/
http://bookboon.com/count/advert/9da50518-808b-41b3-9e08-9fe200fbad87


Download free eBooks at bookboon.com

Excel 2013 Core: Advanced

9 

Contents

15.3	 Data bars	 137
15.4	 Colour scales	 138
15.5	 Icon sets	 140
15.6	 Clear rules	 144
15.7	 Use a formula to control conditional formatting	 144

16	 Sparkline charts	 147
16.1	 Sparkline line chart	 147
16.2	 Column spark lines	 151
16.3	 Creating a win/loss spark line chart	 152
16.4	 Remove a spark line chart	 153

17	 Text functions	 154
17.1	 Text functions – an introduction	 154
17.2	 Concatenate	 155
17.3	 Trim	 157
17.4	 Upper	 159
17.5	 Lower	 160
17.6	 Proper	 161
17.7	 Right	 161
17.8	 Left	 162
17.9	 Mid	 163

18	 Quick analysis	 164
18.1	 Quick analysis	 164
18.2	 Quick analysis Formatting	 165
18.3	 Quick analysis totals	 166
18.4	 Quick analysis Charts	 167
18.5	 Quick analysis Tables	 168
18.6	 Quick analysis sparklines	 169

19	 Macros	 170
19.1	 What is a Mmcro	 170
19.2	 Macro security	 171
19.3	 Get ready	 172
19.4	 Get set and go	 174
19.5	 Run the macro	 175

20	 Index	 177

http://bookboon.com/


Download free eBooks at bookboon.com

Excel 2013 Core: Advanced

10 

About Shelley Fishel

About Shelley Fishel 
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About Excel 2013 Core Advanced

About Excel 2013 Core Advanced
This user guide will introduce you to some of Excel’s more complex functionality. Specifically when 
analysing data.

You will learn how to:

•	 Use Conditional Logic in a formula – IF statements
•	 Use the SumIF and CountIF functions
•	 Produce a chart
•	 Sort and filter
•	 Apply subtotals
•	 Introduction to Pivot Tables 
•	 Introduction to Macros
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Apply Conditional Logic in formula

1	� Apply Conditional Logic 
in formula

1.1	 IF Function (IF Statement)

An If function asks Excel to consider if something is true or false. If it is true it will return one answer, 
if it is false it will return a different answer.

For example: Can my company afford to buy 10 new computers? There are 2 possible outcomes – if it 
is within the budget then the answer is “yes”, if it is outside of the budget then the answer is “no”.

1.1.1	 The structure of an IF Function

=IF(B6<=$B$3,"yes","no")

The structure of an IF statement always contains the same five elements.

•	 Starts with =IF(
•	 The Logical Test followed by a comma
•	 What to do if the logical test is True followed by a comma
•	 What to do if the logical test is False
•	 Close brackets

To make this IF function easier to understand the logical test is in one colour, the true part is in another 
colour and the false part is in a third colour.

1.1.2	 Operators you can use in a Logical Test

Operator Explanation

= Equal to

<> Not equal to

> Greater than

< Less than

>= Greater than or equal to

<= Less than or equal to

http://bookboon.com/
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Apply Conditional Logic in formula

1.1.3	 Typing in an IF Function

Figure 260 – structure of an IF statement

1.	 Click in the cell where you want the answer
2.	 Type in the =IF(
3.	 Type in your logical test
4.	 Type a comma
5.	 Type in what Excel must do if this is true
6.	 Type a comma
7.	 Type in what Excel must do if this is false
8.	 Close the brackets
9.	 Press Enter

If Excel is to display text for the true or false result then you must enclose the text in inverted commas.

You can also put a formula in the IF statement for the True or False result.

For example:

I want to know how much bonus each member of staff will receive:

=IF(B2>$H$1,C2*$h$2,0)

Figure 261 – working out the bonus amount

http://bookboon.com/
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Apply Conditional Logic in formula

1.2	 Nested IF Function

A nested IF Function is an IF function nested inside another IF function.

The basic IF function only allows for two possible answers: either the logical test is met or it is not. 
When we want more than these two basic answers then we need to nest the formula, i.e. put one =IF 
inside another.

You can nest up to sixty four IF functions inside one another, but if you were going to go so far, you 
would be more likely to use a HLOOKUP or VLOOKUP.

1.2.1	 The structure of a nested IF Function

=IF(B5>=$G$2,”OAP”,If(B5<=$G$3,”Child”,”Adult”))

A nested IF Function is just a lot of single IF functions strung together. The structure of nested IFs is 
always as follows:

•	 Start with =IF( 
•	 First logical test followed by a comma
•	 What to do if the first logical test is true 
•	 If the first logical test is false then Excel has to move onto the next logical test which will 

always start with IF( 
•	 Second logical test followed by comma 
•	 If the second logical test is also false Excel moves onto the next logical test and this process 

repeats until you come to the last logical test
•	 At the end of the nested IF there will be your last logical test
•	 What to do if the last logical test is true 
•	 What to do if the last logical test is false 

You must type in a closing bracket at the end of the nested IF for each logical test you have entered.

http://bookboon.com/


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Advanced

15 

Apply Conditional Logic in formula

1.3	 COUNTIF Function

The COUNTIF function combines the COUNT function and the IF function. Use it when you want to 
count any cells that match a certain condition.

Figure 262 – count how many people have overtime
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In the example, we want Excel to count how many people have worked enough hours to qualify for 
overtime. So we set up a COUNTIF Function to count how many times the word “Overtime” occurs in 
the Overtime column.

Figure 263 – result returned

1.3.1	 The structure of a COUNTIF Function

=COUNTIF(C6:C9,"yes")

This says, look in the cells C6 to C9, and if you find the work yes in them count how many times.

The structure of a COUNTIF always contains the same four elements.

•	 Starts with =COUNTIF(
•	 The range of cells that Excel is to look at
•	 The criteria which Excel will use to count
•	 Close brackets

To make this COUNTIF function easier to understand in this example, the range is in purple text and 
the criteria is orange text.

http://bookboon.com/
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Apply Conditional Logic in formula

1.3.2	 Typing in a COUNTIF Function

Figure 264 – type the Countif function directly into the cell

1.	 Click in the cell where you want the answer
2.	 Type =COUNTIF(
3.	 Highlight the range of cells you are counting from 
4.	 Type in your criteria
5.	 Press Enter

1.4	 SUMIF Function
This function will add the value of cells that meet a certain criteria. 

For example, suppose we want to calculate the total salary cost of all females:

Figure 265 – Sumif adds up all the rows that meet your criteria

If the range B2 to B7 says Female then add up all of the salaries that correspond.

The answer for the Total Female Salaries = £79,000.

1.4.1	 The structure of a SUMIF Function

The syntax for the SUMIF function is as follows:

=SUMIF(Range,Criteria,Sum Range)

Range:			   The range of cells that Excel is to look at

Criteria:		  The criteria that the cells must meet in order to be added

Sum Range:		  The cells to Sum

http://bookboon.com/
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Create and apply Range Names

2	 Create and apply Range Names
2.1	 Defining a Named Cell or Range of Cells

A Named Cell or Range of Cells can help in different ways. When a cell is named it behaves as an Absolute 
Cell Reference, by giving the cell a name such as VAT or Price, Excel knows to refer to that particular 
cell when you use it in a formula.

Name a Range of Cells and you can navigate around easily. When used in a formula Excel will pick up 
the right cell in the formula.

Named Ranges are also handy for summarizing data quickly or finding a piece of data at the intersection 
between two ranges. Read on to learn how this works.

2.1.1	 Name a single cell

Figure 266 – Name a cell for easy to read formula

1.	 Click on the cell you want to name ( in our example F1)
2.	 Click into the Name Box (to the left of the Formula Bar)
3.	 Over type the cell reference with the Name for the cell (In our example VAT)
4.	 Press Enter to confirm the name
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Create and apply Range Names

Now I have a cell called VAT which can be seen from the drop down arrow in the Name Box

Figure 267 – see names cells in the name box

Here you can see that my cursor is in Cell G7 and in the drop down arrow is the name VAT.
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To move the cursor to the cell called VAT I can select it from the drop down list.

Figure 268 – use named cells to navigate around

Here you can see that I have now jumped to the cell called VAT and this is where the cursor is 
now positioned.

2.2	 Using a Named Cell in a formula

I can now use my named cell in a formula to:

•	 Make it more readable 
•	 Use it as an Absolute Cell Reference

Figure 269 – Named cells are absolute

Create the formula as you normally would.

1.	 Click into the cell where the result will display
2.	 Type an = sign
3.	 Click on the first cell to include
4.	 Type the mathematical Operator ( in our example an Asterix for multiply)
5.	 Click on the cell with the multiplier in (F1 which is called VAT) Notice that Excel calls the 

cell by its name not the cell reference
6.	 Press Enter

http://bookboon.com/
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Create and apply Range Names

2.2.1	 Auto fill the formula

Figure 270 – as an Absolute reference the named cell allows you to Auto fill your list

Use the Auto fill Handle (the little black plus sign in the bottom right hand corner of the cell) to copy 
the formula down all the other rows.

Figure 271 – all the cells have the correct references in the formula

Notice that each of the rows has adjusted the first part so B2 then B3 then B4 etc however all of the 
formula reference the cell called VAT.
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2.3	 Naming a range of cells

Named ranges can be used to navigate, select and be used in formula to make them more understandable. 
Named cells are absolute and so make copying formula really simple.

2.3.1	 Create a Named Range from a selection

Figure 272 – Name, cells or ranges of cells
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I already have a cell called VAT and I would like to make creating my formula even easier.

I would like the formula to read: Computer*VAT, or TV*VAT

I need to Create Names from Selection – here is how:

1.	 Select the cells to name along with the cells that contain the labels
2.	 Click on the Formulas Ribbon
3.	 In the Defined Names group click on Create from Selection
4.	 In the Dialogue box that pops up, select the correct position for the name  

(in our case Left Column)
5.	 Click OK

2.3.2	 Use a name in a formula

Figure 273 – names in formula

I now have Computer*VAT and can create TV*VAT, Radio*VAT and Speakers*VAT

Figure 274 – easier to read

All the cells show the correct function using the named cells. Much easier to read and makes so much 
more sense.
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Create and apply Range Names

2.4	 Editing and renaming a named range

If you want to you can edit a range, maybe it needs to refer to a different group of cells or you need to 
give it a different name, using the Name Manager.

2.4.1	 The Name Manager

Figure 275 – use the name manager

Click on the Name Manager Icon and in the dialogue box that appears decide what you want to do:

Rename a range – click the range to rename then click Edit and type a new name for the range.
Change the cells referenced – Click the range to change then click Edit and select the cells to use.
Delete a Range – if you no longer need that range you can delete it entirely. 

http://bookboon.com/
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2.5	 Define a Name Using the Dialogue Box

In my spreadsheet I already have a cell called VAT and now I want to create a couple of new ranges. I 
will use the Define Name icon. 

2.5.1	 Define a Name

Figure 276 – define a new name

1.	 Click on Define Name in the Define Names group
2.	 Type a name for the new range in the Name box
3.	 Select the cells to which the new name refers
4.	 Click OK

Figure 277 – new range created
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Here is my new range

Name: VAT col (I already have a cell called VAT)
Refers to: =VAT!$C$2:$C$5 

VAT! Is the worksheet the range is on and $C$2:$C$5 is the range of cells it refers to.

Figure 278 – new name in the list in the name box
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2.6	 Sum a range

Now that I have a defined name for both the VAT column and the Cost Column I can get Excel to add 
them all up.

Figure 279 – sum a range

1.	 Click into the cell where the answer will display
2.	 Type an = sign
3.	 Type Sum followed by an open bracket
4.	 Start to type the name of the range and you will see a yellow label pop up, You can double 

click on the label to include it or carry on typing the name of the range to sum.
5.	 Close the brackets
6.	 Press Enter

Figure 280 – sum a range

http://bookboon.com/


Download free eBooks at bookboon.com

Excel 2013 Core: Advanced

28 
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I can now do the same for the Vat Column.

Figure 281 – all done

Voila! Here are the totals and not a cell reference in sight!

Figure 282 – here are the formula displayed so you can see what is going on behind the function
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3	 Charts
3.1	 Using Quick Analysis

As we have seen elsewhere in this book, Quick Analysis also offers a choice of Charts depending on the 
data that you select first.

3.1.1	 Quick Analysis Charts

Figure 283 – Quick Analysis offers a selection of recommended charts
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Select the data and then click on the small Quick Analysis button – choose Charts and then hover over the 
different recommended charts to see what they look like. Find the one that does the job and click on it.

3.2	 Recommended Charts

When creating a chart, it is sometimes a challenge to decide which chart type to use. In Excel 2013, you 
can now get a recommendation and see samples of the charts that Excel thinks fit your data. It is quite 
useful to see what it looks like before deciding if it is the right one for you.

3.2.1	 Let Excel recommend a chart

Figure 284 – Excel will recommend charts based on your data selection

1.	 Select the data for the chart
2.	 Click on the Insert Ribbon
3.	 Click on Recommended Charts
4.	 Choose one of the charts that Excel suggests 
5.	 Click OK

http://bookboon.com/


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Advanced

31 

Charts

3.2.2	 The chart appears – magic!

Figure 285 – Recommended chart appears

The chart type selected now appears on the spreadsheet next to the data, ready for a Chart Title or to 
be reformatted to match your style.
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3.3	 Creating charts with the keyboard

A very quick and simple way to create a column chart in Excel is to use the keyboard shortcut F11

Simply highlight the data for the chart and press the F11 key. F11 is one of the function keys along the 
top of your keyboard.

3.3.1	 Create a chart using the keyboard

Figure 286 – select your data

Highlight the data for the chart

Press the F11 key
Chart appears on a new worksheet

Figure 287 – it is magic
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Edit as normal

Figure 288 – edit the chart in the normal way
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3.4	 Creating line charts

To create a line chart, you need to select the data and then the type of chart to create.

3.4.1	 Line chart

Figure 289 – Choose the Line Chart Icon

To create a line chart:

1.	 Select the data
2.	 Click on the Insert Ribbon
3.	 Click on the drop down arrow under Line Chart
4.	 Choose the type of line chart you require
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3.4.2	 The line chart

Figure 290 – the Line Chart chosen appears

Here is the line chart I just created. It looks almost fine to me. The only thing is, the way the data is 
arranged does not make as much sense to me as I would like. I need to switch the rows and columns. 
At the moment the chart is showing me the series of Jan, Feb and Mar Sales. The lines are the different 
total sales. I would prefer to see the coloured lines as the types of coffee sold

To achieve this I can click on Switch Row/Columns and Excel will change it in a second.

3.4.1	 Switch Row/Columns

Figure 291 – Switch Rows/Columns

I clicked on Switch Row/Column and now the series are the types of coffee so I can see how each coffee 
is performing here in the Line Chart.
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3.5	 Creating and editing a column chart

Column charts are great when used with data that has up to 12 data points. If your data has fewer than 
12 data points or ranges then choose a column chart.

3.5.1	 Insert a column Chart

Figure 292 – Sales of each type of drink sold at Coffee Island

1.	 Select the data you want to chart
2.	 Click on the Insert Ribbon Tab
3.	 Select the type of column chart you want to use – note that Excel does help by giving you 

pointer on when to use each type of chart
4.	 The chart is placed on your spreadsheet immediately
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3.5.2	 Edit the chart

Figure 293 – many ways to format a chart

In Excel 2013 there are more ways to get to the various customization options. 

When you add a chart Excel pops up two new Ribbons, Design and Format. Use these Ribbons to change 
the way your chart looks and is formatted. (1)

New in Excel 2013 is the ability to add and change chart elements from the pop out icons next to the 
chart itself. (2)
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3.6	 Creating pie charts

A pie chart is great for showing the way that 100% is divided between the items you are charting. I can 
either see how the coffee sales divide up among the months, or how each month divides up amongst 
the coffee types. As a pie chart looks at just 100% it is not used to compare, in the same way a column 
or bar chart are used.

3.6.1	 Pie chart

Figure 294 – a pie chart divides 100% into segments

1.	 Select the data
2.	 Click on the Insert Ribbon
3.	 Click on the drop down below the Pie Chart Icon
4.	 Choose which type of pie chart you want to use
5.	 The pie chart Appears!

I am looking at how the different types of coffee divide up in January so I selected just the January figures 
with the types of coffee labels.

3.7	 Modifying charts using the Ribbon

The way that charts are modified follows the same general process for all chart types. There are two 
ways to modify charts:

•	 The Ribbon
•	 The Chart Tools on the worksheet next to the chart.
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3.7.1	 Using the ribbon

Figure 295 – Contextual ribbons for charts

When you have added a chart to your worksheet, you will notice the appearance of two new Ribbon 
Tabs under the general heading Chart Tools.

The Design Tab and the Format Tab

3.7.2	 The Design Ribbon

Figure 296 – The Design Ribbon

The Design Ribbon offers you lots of ways to customize the chart and make it your own style. 
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3.7.3	 Add chart elements

Figure 297 – add Chart Elements to make the chart easier to read

Chart Elements allow you to add elements to your chart to make it easier to read or style

Chart Title – decide if you want a title and where it goes
Data Labels – again you decide how they are placed and where
Data Table – this depends on the type of chart you are working with – it allows you to add the data 
underneath the chart – try it out and see 
Legend – allows you to add a legend and decide on its placement 
Lines – this will be available if you have a chart that supports it
Trend line – again if you have data and the right type of chart this will be live
Up Down Bars – in a Line Chart you can add Up Down Bars to show movement
Grid lines – this option is available when you have a chart that supports displaying grid lines
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3.7.4	 Quick layout

Figure 298 – change the way the chart looks quickly

Use the Quick Layout to change the way the data is set out – you can choose from a selection of presets.

3.7.5	 Change colours

Figure 299 – modify colours to match your style

Change the colours of the bars or lines in your chart with the Change Colours icon. Select from colourful 
or monochrome themes.
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3.7.6	 Chart Styles

Figure 300 – make a chart your own by changing the style

Select from one of the preset chart styles in the gallery to change how your chart displays. You will see a 
live preview of how it looks as you hover over the different styles and by clicking on the style it is applied.

3.7.7	 Switch Row/Column

Figure 301 – change how the chart uses your data

In the chart I have the months as the series and the types of coffee in clusters – if I want to see the data 
the other way around I can Switch Row/Columns.
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3.7.8	 Select Data

Figure 302 – add extra series or data to a chart

In the event that you created a chart and forgot to include some data or you have added data to the 
range for the chart at a later date and now want to include it, you can use the Select Data button to add 
more data.

1.	 Select the data including the new data you want to add
2.	 Click the Select Data button
3.	 Your new range will appear in the list and be added to the chart when you click OK
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3.7.9	 Change Chart Type

Figure 303 – wrong chart – no problem, just change it!

If you decide that the type of chart you selected does not fit the purpose you need, change the type of 
chart altogether.

1.	 Click Change Chart Type
2.	 Choose a different chart from within the charts offered
3.	 Click OK
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3.7.10	 Move Chart

Figure 304 – move it to another location

If you want to move the chart to another worksheet or location you can use the Move Chart button.
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3.8	 Modifying charts using icons

When you add a chart to your worksheet, three icons pop up alongside: Elements, Style and Filter. These 
allow you to work with the chart directly without having to go up to the Ribbon.

3.8.1	 Icons

Figure 305 – use the icons to modify the chart right on your screen

1.	 Elements
2.	 Styles
3.	 Filter

3.8.2	 Elements

Figure 306 – add or remove different elements

Click on the icon to select the different types of elements you can add to a chart. You will be offered the 
elements that are relevant to the chart type you used.
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3.8.3	 Styles

Figure 307 – change the style

Click the style icon to see the different style options. You can also change the colours here by clicking 
on Colour in the header and then selecting the one you want to use.

3.8.4	 Filter

Figure 308 – you can even apply a filter!

Use the filter icon to display or hide different parts of the data. Simply un-check the series or categories 
you want to remove and then click Apply.
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3.9	 Formatting charts – Task Pane

When you double click on parts of a chart you will be offered a task pane with formatting options to 
choose from.

3.9.1	 Format the Chart Area

Figure 309 – use the task pane for more detailed changes

Double click on the chart area and the Format Chart Area task pane appears. Here you can change all 
kinds of formatting – chart and text options, fill, border, shadow, size, font colour, font outline etc.

Click on the different areas within the task pane to expand them and experiment with what they do.
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3.9.2	 Format Data Series

Figure 310 – change just one data series

Double click on a data series – in this example I double clicked on the blue columns for Americano. Now 
I can change how this series looks. If I want it to be in a different colour I can change that by selecting 
a different colour from the drop down next to Colour.

Test out the different options to see how they work.

3.9.3	 Format Plot Area

Figure 311 – format the plot area – add fill or borders and more

Double Click on the plot area and the Plot Area Task Pane opens up with options to change.
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3.9.4	 Format Major Grid lines

Figure 312 – Add major gridlines to help with readability and format them

Double click the major grid lines to get the Format Major Grid lines task pane with all of the available 
options.

3.9.5	 Format Axis

Figure 313 – add an axis or change how the axis looks

Double click on the axis you want to format, and the Format Axis task pane displays. Here you will see 
options to format the axis or the text. In my example, I have changed the text to orange to make it stand 
out a bit more. Try out all the different options.
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4	� Apply and manipulate 
illustrations

4.1	 Pictures in Excel

In Excel, as in the other Microsoft Office programs, you can add pictures to make your work more 
interesting. You might want to add a logo or a piece of Smart Art to illustrate a point. Familiar tools 
from other applications are available in Excel 2013.

4.1.1	 Insert a picture from a file on your computer

Figure 314 – insert picture from file

1.	 Place the cursor where you want the picture to appear
2.	 Click on the Insert Ribbon
3.	 Click on Pictures
4.	 Navigate to the folder where your picture is stored (mine is in a folder called Coffee in my 

Pictures Library)
5.	 Click Insert
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4.1.2	 Insert an online Ppcture

Figure 315 – add an online picture

If you don’t have a picture on your computer you can go online for more options.

•	 From SharePoint – if you are using SharePoint in your organization, you may have pictures 
stored there and you can search for them by clicking Browse

•	 Office.com Clip Art – if you are looking for some Clip Art, go online to Office.com by 
typing a keyword and then clicking the magnifying glass

•	 Bing Image Search – type your keyword here and click on the Magnifying Glass to search

Figure 316 – images from Bing

Bing will offer you a selection of images and a warning about copyright. Make sure you comply!

Click on the image you want to use and click Insert.
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The picture is downloaded and inserted into your document. You may well need to resize it too!

Figure 317 – image added
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4.2	 Resize the picture – dragging

Pictures will pop into your spreadsheet and often be far too large. Use the following methods to 
resize them.

4.2.1	 Reside the picture – dragging

Figure 318 – click and drag on the diagonal to keep proportion

Grab the corner and when you see the diagonal white arrow drag the cursor down and to the right – 
keeping the ratio of the long and short edges proportional.

4.2.2	 Resize the picture using the Ribbon

Figure 319 – set an actual size on the Ribbon

1.	 Click on the picture to select it
2.	 Click into the height or width box in the Size Group on the Picture Tools Format Ribbon
3.	 Type the size you want the picture to be
4.	 Excel will automatically change the other value to keep the picture proportional
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4.3	 Modify a picture

Excel 2013, like the other Microsoft Office applications, offers many ways to modify and enhance your 
pictures. Use the Picture Tools Format Ribbon to make changes.

4.3.1	 Picture Tools Format Ribbon

Figure 320 – The picture tools Format Ribbon

Here you can add a picture style, a border, and picture effects such as shadow change the picture layout. 
You can also send images backwards and bring them forwards if you have several. 

Crop an image to remove the parts you don’t need and adjust the size.

4.3.2	 Add a style to a picture

Figure 321 – style your picture

Select the picture and then hover over the styles in the Picture Styles Gallery and see how your picture 
will look. When you find one that you like, click on it to apply.
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4.3.3	 Change Border Colour

Figure 322 – give the picture a border

1.	 Click on the picture
2.	 Click on the drop down next to Picture Border
3.	 Choose a colour 

You can choose many more colour options and even change the weight and type of line that makes up 
the border.

Try out the different options.
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4.3.4	 Picture effects

Figure 323 – change picture effects

These add shadow, glow, bevelled and different colour effects.

4.3.5	 Crop a picture

Figure 324 – crop to remove unwanted parts 

When you want to remove parts of a picture rather than re size it, you can crop it. Click the Crop icon 
and then drag the crop handles that appear around the picture to remove parts.
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4.3.6	 Brightness sharpness and contrast

Figure 325 – make the picture brighter or sharper here

You can change the sharpness or saturation of an image, the brightness and the contrast. Click the icon 
and make a choice. Live Preview will show you what the picture will look like and when you find what 
works, click on the icon to apply.

4.3.7	 Adjust the colour

Figure 326 – if ou want to recolour the picture, do it here

If you want to change the colour of the picture, perhaps to match the theme of your spreadsheet, you 
can select a colour tone, or recolour the picture from the colour button. Test out some of the other 
options here.
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4.3.8	 Apply artistic effects

Figure 327 – use Artistic Effects to really change how it looks

You can change the picture in other ways by selecting from one of the artistic effects available.

1.	 Click on the Picture
2.	 Click the drop down arrow next to Artistic Effects
3.	 Select the effect you want to apply

EADS unites a leading aircraft manufacturer, the world’s largest 
helicopter supplier, a global leader in space programmes and a 
worldwide leader in global security solutions and systems to form 
Europe’s largest defence and aerospace group. More than 
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter, 
in 90 locations globally, to deliver some of the industry’s most 
exciting projects.

An EADS internship offers the chance to use your theoretical 
knowledge and apply it first-hand to real situations and assignments 
during your studies. Given a high level of responsibility, plenty of 

learning and development opportunities, and all the support you need, 
you will tackle interesting challenges on state-of-the-art products.

We welcome more than 5,000 interns every year across 
disciplines ranging from engineering, IT, procurement and 
finance, to strategy, customer support, marketing and sales. 
Positions are available in France, Germany, Spain and the UK.

To find out more and apply, visit www.jobs.eads.com. You can also 
find out more on our EADS Careers Facebook page.

Internship opportunities

CHALLENGING PERSPECTIVES

http://bookboon.com/
http://bookboon.com/count/advert/85f92380-2160-4386-98b4-a2540089b583


Download free eBooks at bookboon.com

Excel 2013 Core: Advanced

60 

Apply and manipulate illustrations

4.4	 Reset a picture

If you are anything like me, you will try out all sorts of different effects on your picture and then decide 
that you like it just the way it was. In this case you need to Reset the Picture to its original state.

4.4.1	 Reset a picture

Figure 328 – reset the picture to how it started out

Click the Reset Picture icon

Choose whether to simply reset the colour/brightness back to how it was – or if you also resized the 
picture, you can choose to take it back to its original size too.
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5	 SmartArt
5.1	 SmartArt

SmartArt is a way of presenting data such as a process, a hierarchy or an idea visually. It can jazz up a 
boring spreadsheet.

5.1.1	 Add process SmartArt

Figure 329 – create a process diagram

On the Insert Ribbon

1.	 Click SmartArt
2.	 Choose a style from those on offer
3.	 Click OK
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5.1.2	 Add text

Figure 330 – add text

A text pane pops out of the left side of SmartArt and you can type your text in here – or you can type 
directly into the shapes.
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5.1.3	 Change the colour of SmartArt

Figure 331 – change the colour

On the SmartArt Tools Design Ribbon that pops up, you can select a different colour set for the SmartArt.

5.1.4	 Make other changes

Figure 332 – Smart Art design

Other changes you can make to SmartArt on the Design Ribbon are:

•	 Adding more shapes
•	 Changing the overall layout
•	 Change the colours
•	 Change SmartArt styles
•	 Reset to how it started out once you made changes
•	 Convert to Shapes takes away the automatic functionality of SmartArt and turns the 

SmartArt into one big shape
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On the Format Ribbon you can:

•	 Change the individual shapes 
•	 Change the shape styles – border and shading
•	 Format the Word Art within the shapes
•	 Apply text formatting
•	 Arrange and align
•	 Re-size
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6	 Shapes
6.1	 Inserting shapes into a workbook

Shapes can be drawn onto a worksheet to illustrate a point or to look like a button or label.

6.1.1	 Insert shapes

Figure 333 – add shapes

1.	 Click on the Insert Ribbon
2.	 Click the drop down arrow next to Shapes
3.	 Choose a shape

6.1.2	 Draw the shape

Figure 334 – drag to draw the shape

Click and drag out the shape until it reaches the size you want.
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6.1.3	 Format the shape

Figure 335 – the Format Ribbon

You can now use the Drawing Tools Format Ribbon to make changes to how your shapes appear. Change 
the colour, the border the fill, how any text looks and any alignment and size.

6.1.4	 Add text to a shape

Figure 336 – add text

Click into the shape and start typing

6.1.5	 Edit text

Figure 337 – Edit the text

Right Click on the shape and click Edit Text – you can now change what you had already entered.
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7	 Screenshots
7.1	 Inserting a screenshot

Sometimes, when you need to illustrate a point, it would be handy to have a screen shot to show what 
you mean. With Office 2013 you can now add screen shots just about anywhere.

7.1.1	 Take a screen clipping of part of a window

Figure 338 – get a screen clipping

Here I have gone to a different workbook which is open behind the one where I want to place the clipping. 
Having clicked on Screen Clipping at the bottom of the menu I then clicked into the worksheet for which 
I want to get a screen shot. The screen goes white. I can then click and drag over the white area to get 
what I want and that part of the screen goes bright as you can see in the image above. When I let go the 
image is placed in the worksheet I started from.
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7.1.2	 Add a screen shot

Figure 339 – add a screen clipping

The Screen Clipping tool works by taking a screen shot of the whole screen or by allowing you to draw 
the area that you want to clip. As Excel 2013 works with each workbook opening in its own instance it 
is easy to get a clipping of just part of a window.

To get a picture of the whole of the screen in another application, web page or workbook click on the 
window you want to capture in the Available Windows section.

If however you want to get just part of the screen, then use the Screen Clipping command at the bottom 
of the window.

7.1.3	 Take a screen clipping of a section of the screen

Figure 340 – clip a section

1.	 Click Screen Clipping at the bottom of the insert screen shot menu
2.	 Then switch to the screen you want to clip from
3.	 You will see a big black plus sign
4.	 Click and drag over the area you want to clip – note that the screen has gone white and the 

area you select goes bright
5.	 When you let go, the clipping will appear in the worksheet you started from
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8	 Manage comments
8.1	 Inserting and editing comments

Comments are like little yellow post it notes that sit in your spreadsheet. They are useful to remind 
yourself what you did or for explaining changes made to those who are using the spreadsheet.

8.1.1	 Add a comment

Figure 341 – adding comments

1.	 Click on the Review Tab (1)
2.	 Click New Comment (2)

Figure 342 – a red comment indicator and yellow comment

A yellow comment is added to the worksheet and a small red triangle is displayed top right of the cell. 
Type the comment into the yellow post it note.

8.1.2	 How do I know if there is a comment?

Figure 343 – the red triangle indicates a comment

The cell containing the comment has a small red triangle to show that a comment exists.
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8.1.4	 To see the comment

Figure 344 – hover to see the comment

Hover or click on the cell with the comment indicator.

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

www.discovermitas.com

http://bookboon.com/
http://bookboon.com/count/advert/9da50518-808b-41b3-9e08-9fe200fbad87


Download free eBooks at bookboon.com

Excel 2013 Core: Advanced

71 

Manage comments

8.1.5	 Edit a comment

Figure 345 – use the Ribbon to edit a comment

Click on Edit Comment, the comment will then pop up on the worksheet so that you can change what 
is written inside.

You can also Right Click with the mouse on the cell with the comment indicator and select Edit Comment.

Figure 346 – Right click to edit a comment

8.2	 Deleting comments

8.2.1	 Delete a comment via the Ribbon

Figure 347 – Delete a comment via the Ribbon

1.	 Click on the cell with the comment
2.	 On the Review Ribbon click on the Delete icon
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8.2.2	 Delete comment via Right Click

Figure 348 – Delete a comment with a right click

1.	 Right click on the cell with the comment
2.	 Select Delete Comment

8.3	 Show/Hide Comments

If you want to see the comments displayed on the screen all the time you can show them. Then when 
you no longer need to see them you can hide them.

8.3.1	 Show comments

Figure 349 – display the comments permanently

1.	 Click on the cell with the comment indicator
2.	 Click on Show/Hide Comments

The comment is now displayed on screen and if you move to another cell it stays put!
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8.3.2	 Hide comments

Figure 350 – hide comments

Click on Show/Hide Comments – the comment is now hidden.
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8.3.3	 Show all comments

Figure 351 – display all comments

To display all comments together rather than going through them one-by-one, you can click on Show 
All Comments.

To hide them again click Show All Comments again.

8.4	 Moving between comments

When you have lots of comments on your spreadsheet, it can be useful to display them one after the other. 

8.4.1	 Move to next comment

Figure 352 – next and previous to move between comments

From the first comment cell – click on Next 

8.4.2	 Move to previous comment

Figure 353 – previous to move back

Click on Previous in the Comments group.
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8.5	 Printing comments

Comments do not print. They are there on screen as a reminder. If you want to print them you can have 
them print on screen exactly as they appear or print them at the end of the sheet.

8.5.1	 Print comments on the worksheet

Figure 354 – print comments

1.	 Display the comments on the worksheet first
2.	 Click File
3.	 Click Print
4.	 Click on Page Setup

Figure 355 – decide where you want to print them

1.	 Click on the Sheet tab 
2.	 Select As displayed on sheet
3.	 Click OK
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8.5.2	 Print comments at the end of the worksheet

Figure 356 – print the comments at the end

1.	 Click File
2.	 Click Print
3.	 Click Page Setup
4.	 Click the Sheet Tab
5.	 Select At end of sheet

Figure 357 – comments at the end of the worksheet

Now the comments show at the end of the sheet, here we are on page 2 of 2 and the comments are shown.
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9	 Sorting data
9.1	 Databases in Excel – introduction

A Database is a structured collection of information.

A Database in Excel is structured in a very particular way:

The data is broken up into separate Fields that can be applied to every record in the database e.g. an 
addresses database might have fields for first name, last name and so on. These fields make up the columns 
of the database. The field names are usually in the first row of the database.

Each subsequent row contains the data for each Record – one record per row.

Databases or lists have NO blank Columns and NO blank Rows. It is possible to have a blank cell, however 
as soon as Excel detects a blank row or a blank column the rest of the data is treated as a separate list. 
We will see an example of this a little later on.
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Figure 358 – structure of a database

1.	 Field Names in the first row
2.	 Records – one separate record in each subsequent row

9.2	 Sort data

In the Coffee Island sales list, there are different columns. Depending on the type of data analysis that 
needs to be done, the data will need to be sorted in different ways.

There are several ways to get to the tools to sort data. There is a Sort on the Home Tab, more detailed 
Sort options on the Data tab and of course there is a right click option. You can also add the Sort Icons 
to the Quick Access Toolbar.
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9.2.1	 To perform a simple sort from the Home tab

Figure 359 – click into the column to sort by and then sort

1.	 Click anywhere in the column you want to sort by
2.	 Click on the Home tab
3.	 Click on the Sort & Filter button (1)
4.	 Select Sort A to Z, Or
5.	 Select Sort Z to A
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9.2.2	 To perform a simple sort using the Data tab

Figure 360 – sort from the Data Ribbon

1.	 Click anywhere in the column you want to sort by
2.	 Click on the Data tab on the Ribbon 
3.	 Go to the Sort & Filter group 
4.	 Select Sort A to Z, Or
5.	 Select Sort Z to A
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9.2.3	 Sort with a right click

Figure 361 – sort on a right click

1.	 Click into the column you want to sort by
2.	 Right Click
3.	 Click on Sort
4.	 Select how you want to sort the data
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9.2.4	 To perform a custom sort (Multi Level Sorting)

Figure 362 – custom or multi-level sort

1.	 Click on the Data tab
2.	 Click on the Sort button 
3.	 Click on the down arrow by Sort to select the Column you want to sort by 
4.	 Choose what you want to sort on – Values, Cell Colour, Font Colour, Cell Icon
5.	 Select the Order you want to sort by, A–Z, New to Old, Z–A, Old to New depending on 

the data.
6.	 If you want to sort on more than one column: Click on the Add Level button 
7.	 Repeat steps 3–5
8.	 Click OK

To delete a level, click on the Delete Level button 

You can also access the Custom Sort via the right click option.
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9.2.5	 Change the order of the sort levels

Figure 363 – change the order

If you want to change the sort order, click on the up or down arrows along the top of the Multi-Level 
sort box. Here I have changed the order to Item first then CentreCentre.
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9.3	 Sort on font colour

If you have changed the font colour of certain parts of your data you can sort by font colour.

9.3.1	 Selected font colour on top

Figure 364 – sort by font colour

1.	 Right Click on the cell with the font colour you want to have at the top of your list
2.	 Click Sort
3.	 Then Choose Put Selected Font Colour on Top

9.4	 Sort on cell colour

If you have shaded in some cells you can have them appear at the top of the list.

9.4.1	 Place cell colour on top

Figure 365 – sort on Cell Colour

1.	 Right click on the cell with the shading
2.	 Click Sort
3.	 Select Put Selected Cell Colour on Top
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Figure 366 – coloured cells appear at the top of the list

All of the cells shaded blue are now at the top of the list.

9.5	 Sort on cell icon

If you have used conditional formatting to add icons to cells, you can use these to sort by.

9.5.1	 Put selected cell icon on top

Figure 367 – sort on cell icon – conditional format

1.	 Right click on the cell with the icon you want to have at the top of the list
2.	 Click on Sort
3.	 Select Put Selected Cell Icon on Top
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Figure 368 – all sorted!

My red arrows pointing down are now at the top of the list.
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10	 Filtering data
10.1	 Filter data – the filter icon

Filtering allows you to hide the information that you do not want to see. So if I want to see sales of 
Cappuccino in London only, I can use the filter option to do just that. Then I can change the filter to 
suit my needs and refocus on different sets of data.

10.1.1	 Filter on the Home Tab

Figure 369 – filter from the Home Ribbon

1.	 Click anywhere inside your list
2.	 On the Home Tab click Sort and Filter
3.	 Click Filter 

10.1.1	 Filter on the data tab

Figure 370 – switch on the filter via the Data Ribbon

1.	 Click anywhere inside your list
2.	 Click on the Data Icon
3.	 Click Filter in the Sort and Filter Group
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10.2	 Filter on text

Now that you know where the filter lives, let’s use it to find sales of Cappuccinos.

Figure 371 – pull out the records you want to see

1.	 Click on the drop down arrow by the column heading you want to filter
2.	 Un-check Select All
3.	 Select the item on which you want to filter
4.	 Click OK

Figure 372 – records that do not match criteria are hidden

I now have only rows where the value in the Item column is Cappuccino.
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10.2.1	 Use the Right Click

Figure 373 – filter is also on the Right Click

1.	 Right click on the cell with the value you want to filter out – in my example, I have clicked 
on a cell with Cappuccino 

2.	 Click Filter
3.	 Click on Filter by Selected Cell’s Value

You will now see only rows with the value you chose.
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10.3	 Filter on more than one column

I would now like to see the sales of Cappuccino in Manchester only. I will apply the filter to both the 
Item and the Centrecentre columns.

10.3.1	 Apply the filter to another column

Figure 374 – keep adding filters to narrow down your results

1.	 Click on the drop down arrow next to the second column to filter on
2.	 Un-check Select All
3.	 Click to select the item on which you want to filter
4.	 Click OK

Figure 375

I now have only rows where Cappuccino was sold in Manchester. 

You can tell that rows have been hidden by looking at the row numbers – which will also have turned blue.
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10.4	 Remove the filter

Now I want to see all of the data. There are a few ways to clear the filter.

10.4.1	 Clear the filter

Figure 376 – clear a filter

Click on Clear 

All the data comes back with the Auto filter arrows still in place

10.4.2	 Turn off the filter

Figure 377 – turn off the filter altogether

Click on the Filter icon

The filter is cleared and the auto filter arrows are removed

10.4.3	 Clear the filter from one column only

Figure 378 – clear just one filter

1.	 Click the drop down arrow of the column whose filter you want to clear
2.	 Select Clear Filter From “the field name”
3.	 Click OK
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10.4.4	 Remove with Right Click

Figure 379 – use the right click

1.	 Right click in the column you have filtered
2.	 Select Filter
3.	 Select Clear Filter From “Name of Column” (in our example it is from the Item Column)

10.5	 Filter data on colour

If you have applied conditional formatting to your list to show data with certain cell colours, or font 
colours, you can make Excel show you just those cells. Just like when sorting by colour.

10.5.1	 Filter on font colour

Figure 380 – Filter on font colour
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In my Number Sold column I have changed some values to show in Red text.

1.	 Click the drop down of the column you want to filter
2.	 Click on Filter by Colour
3.	 Choose the colour you want to see
4.	 Click OK

Figure 381 – only rows in red show up

Only cells that have a red font are shown.
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10.5.2	 Filter on cell colour

Figure 382 – filter on shaded rows

I have coloured all cells that have a value greater than 500 orange and now want to see only those rows.

1.	 Click the drop down of the column you want to filter
2.	 Click on Filter by Cell Colour
3.	 Choose the Colour you want to see
4.	 Click OK

Figure 383 – only shaded rows shown.
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10.5.3	 Clear the filter

Figure 384 – clear the filter

1.	 Click the drop down arrow on the column you want to clear the filter from
2.	 Click Clear Filter from “name of column”

Remember you can also clear the filter with a Right Click or via the Data Tab and Clear Filter.

10.6	 Text filters

Say you need to filter out rows that begin with a certain letter or contain a particular value, that contain 
a particular word or in fact do not contain a particular word. These can all be done from the drop 
down arrows. 

Here we will take a look at Text Filters.

Figure 385 – different text filters available

1.	 Click the drop down arrow on the heading of the column to filter
2.	 Select Text Filters
3.	 Choose the filter you want to apply
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I want to find all rows where the item begins with C.

Figure 386 – set criteria

1.	 In the Custom Auto Filter box that appears
2.	 Type the criteria
3.	 Click OK

Figure 387 – text filter applied

I now only see rows where the item begins with C.

10.7	 Number filters

Excel has many more filters for numbers than a simple select all rows with this number option. We can 
look for rows with a value greater than one we specify, or less than, equal to or between.
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10.7.1	 Number filters

Figure 388 – Number filters

1.	 Click the drop down arrow on the heading of the column you want to filter
2.	 Select Number Filters
3.	 Choose the filter that matches your criteria

Figure 389 – Set criteria

I chose Greater Than…

1.	 In the dialogue box type in the criteria – in my case greater than 500
2.	 Click OK
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Figure 390 – Result matches my criteria

Now I only see rows where the value is greater than 500 in the Number Sold column.

Get Help Now

Go to www.helpmyassignment.co.uk for more info

Need help with your
dissertation?
Get in-depth feedback & advice from experts in your 
topic area. Find out what you can do to improve
the quality of your dissertation!

http://bookboon.com/
http://bookboon.com/count/advert/93324fb6-34af-4083-97e3-a15f00b15c50


Download free eBooks at bookboon.com

Excel 2013 Core: Advanced

99 

Filtering data

10.8	 Date filters

What about finding all sales that happened in a particular month or range of dates? Yes with Excel’s date 
filters you can do just that.

10.8.1	 Date filters

Figure 391 – lots of data filters available

There is a huge choice of date filters. 

I will choose Between and look for all sales that occurred in 2010.

Figure 392 – set criteria
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1.	 Type in the first date of the range – note it says after or equal to – in my example 
01/01/2010 First Jan 2010

2.	 Type in the last date of the range – note it says before or equal to – in my example 
31/12/2010 31st December 2010

3.	 Click OK

Figure 393 – date filter applied

I now only have rows with dates between Jan 1st 2010 and December 31st 2010.

You can try out the different date filters to find what works for you.
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11	 Format as table
11.1	 What is format as table

Reasons to use Tables in Excel 2013:

•	 A filter is switched on as soon as you format the data as a table 
•	 Easily format the table and apply great looking pre-set styles to the data
•	 The Header Row stays in view no matter where you scroll
•	 Apply Banded Columns and Rows easily
•	 Sort the Table from the drop down of any column
•	 Add a total row to the bottom of the data and it will perform calculations on the right most 

column, however you can also add a function to the total row of any numerical column
•	 The table will expand if you add more columns or rows to it and any chart that you have 

based on the table will automatically expand as well.
•	 Calculated columns are added automatically – perform a calculation in the first cell of a new 

column, press enter and the calculation is repeated in the whole column.

Tables in Excel 2013 are great time savers when you want to analyse your data

11.2	 Format as table icon

To turn your list of data into a table, it must have no blank columns or rows. You can have several tables 
on one worksheet if you have different groups of data.

11.2.1	 Format as table

Figure 394 – table styles
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1.	 Click anywhere inside your data list
2.	 Click on the Format as Table Icon
3.	 Select a format to apply

Figure 395 – confirm the range

1.	 You will be prompted to check if the range that Excel finds is correct.
2.	 Click OK if it is.

Figure 396 – style applied

I chose Table Style Medium 4 which is green and has banded rows.
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11.3	 Insert a table

You can insert a Table via the Insert Ribbon and Excel will apply a preset format without giving you the 
choice of how it looks.

Figure 397 – insert a table

1.	 Click inside your data 
2.	 Click on Insert
3.	 Click Table

Figure 398 – confirm the range
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1.	 Check the range is correct 
2.	 Click OK

Figure 399 – Table applied

Excel has applied the automatic formatting and added the filter with drop downs. However I was not 
offered the choice of style for the table as I would have been if I had chosen to Format as Table.

11.3.1	 Keyboard shortcut

To insert a table with the keyboard first make sure your cursor is inside your data and then do one of 
the following:

Control + T
Control + L

Notice that this method applies a preset format and does not offer you a choice of style.

11.4	 Change table style

It is really simple wantto change the style for a table, either because you created it with the keyboard 
and you want to choose, or because you don’t like the one you have.
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11.4.1	 Select a different table style

Figure 400 – change style

1.	 Click inside your table
2.	 In the Table Tools Design Ribbon go to the Table Styles group and select a different style.

Figure 401 – pick the new style

The new colours and banding will apply immediately.
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11.5	 Remove formatting

The fancy table styles can be removed in favour of plain black and white text without affecting the 
automatic features of the table.

11.5.1	 Remove formatting

Figure 402 – select None to remove formatting

1.	 Click inside the table
2.	 In the Table Styles group select the first table labelled None

Figure 403 – this just removes the formatting and leaves functionality

The Table reverts back to plain black and white, however the filter remains and any automatic features 
are still there.
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11.6	 Name the table

When you add a table to an Excel spreadsheet it is given a generic name which can then be used in 
formulas to refer to the data in the table.

Figure 404 – give the table a name

See the name in the Properties Group on the Table Tools Design Ribbon.

Figure 405 – type it!

Click into the box and type the new name for your table. Avoid spaces if you want to refer to the table 
from another worksheet later on.
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11.7	 Calculated columns

An exciting feature of tables in Excel 2013 is the lightning speed at which a new column is added and 
the calculation done in the first cell repeated throughout the column.

In the example below, Coffee Island is increasing all drinks prices by 30% so I have placed 1.3 in cell N1. 
I will use this to work out the new price for each drink and it will be added to the New Price Column. 
Then I want to work out the new total sales price which is Number Sold × New Price per Item.

Excel will do this using Named Ranges in the Table and update the whole column at once.

Figure 406 – type the first formula

•	 The formula starts with an = and then inside [ ] square brackets is the formula
•	 Next comes @[Cost per Item] which is the name of the column referred to in the formula 

enclosed in square brackets (to show it is the name of a range)
•	 Then I have multiplied so a *
•	 Then $N$1 as the value needs to be fixed so that it can be copied to all cells in the column.

When I press Enter this formula is replicated automatically down the whole column.

Figure 407 – formula to replicate

In cell J4 is the same formula.

•	 The cell N1 is fixed so that it is referenced correctly
•	 The @[Cost per Item] means that whatever is on this row in the column called Cost per 

Item will be used
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11.7.1	 Calculated column

Figure 408 – another example

Here is another example:

•	 = to start the formula
•	 @[Number Sold] – whatever is on this row in the Number Sold column
•	 * multiplied by
•	 @[New Cost Per Item] – whatever is on this row in the New Cost Per Item column
•	 All enclosed in [square brackets]

When I press Enter it will be replicated down the whole column.

Figure 409 – calculation is replicated in the whole column

Here you can see in the Formula Bar that the formula in K1 has been replicated in K4.
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11.8	 Add a total row

Adding a total row to the table makes getting a summary really simple. Not only does the total row create 
a formula in the total row, it also adjusts the total if a filter is applied. Magic!

Figure 410 – tick the box for a total row

To add a total row to the table:

1.	 On the Table Tools Design Tab
2.	 Go to the Table Style Options
3.	 Click on Total Row to switch it on

Figure 411 – total row is added

A total row is added to the bottom of the data and the column on the extreme right has a sum created.
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11.8.1	 Change from a sum to something else

Figure 412 – change the calculation

You can change the calculation type to any one of the options in the drop down list.
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11.8.2	 Add a total row to another column

Figure 413 – click the drop down below the column you want to add up

1.	 Click on the drop down arrow in the total row for the column you want to sum
2.	 Select the function you want to add
3.	 Your new total will appear

Figure 414 – total row appears

I now have a total for the Number Sold and a total for the Sales.

11.9	 Convert back to a range (remove automatic functionality)

When you have finished working with your data you may want to remove the automatic functionality 
and change the data back to a regular range.
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11.9.1	 Convert to range

Figure 415 – use the tools group to remove automatic functionality

1.	 Click inside your table
2.	 Click on Convert to Range in the Tools Group.

Figure 416 – make sure the cursor is inside your table

Click Yes to confirm that you do want to convert it back.

11.9.2	 Automatic functionality removed

Figure 417 – automatic functionality removed – style remains

The automatic functionality has been removed although the style has been kept.

If you wantto remove the fancy formatting select the plain style first before converting to a normal range.
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11.9.3	 Remove formatting before converting to a range

Figure 418 – choose None to remove the fancy formatting

1.	 Click inside your table
2.	 Select the first Table Style – it says None when you hover

The Table will revert to Black and White and when you Convert it to a Range, the formatting will be 
gone along with the automatic features.
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12	 Filter a table
12.1	 Filter a table

A table can be filtered in exactly the same way as a list. Only with a few magic extras!

12.1.1	 Filter on one column

Figure 419 – tick the box of the item you want to filter on

1.	 Click on the drop down arrow on the column heading you want to filter
2.	 Un-check Select All
3.	 Select the check box next to the filter item
4.	 Click OK
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12.1.2	 See the results

Figure 420 – filter applied

Now I can see just the rows that match the filter criteria.

12.2	 Filter a table with a total row

When a total tow is added to the table, magic happens! Not only do I get to see just the rows that match 
my criteria, the total will be adjusted as well.

12.2.1	 Total row unfiltered

Figure 421 – regular total row

Here is my Coffee Sales worksheet with a total row and no filter. The Total Sales is £176,141.22
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12.2.2	 Total row filtered

Figure 422 – filter applied

Note that the total row is now £50,507.70! Only the Cappuccino rows have been totalled. Magic!
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12.3	 Insert a slicer

Slicers are cool! Slicers allow you to filter your data from nice big buttons on the spreadsheet. See how 
to add and use one here.

12.3.1	 Insert a slicer

Figure 423 – add a slicer

1.	 Click Insert Slicer
2.	 Select the field name you want to use as a filter
3.	 Click OK

12.3.2	 A slicer

Figure 424 – slicer appears with nice big filter buttons

I now have a slicer. Each of the blue buttons can be used to apply a filter.
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12.3.3	 Filter the table using the slicer

Figure 425 – using a slicer

Having clicked on the button for Cappuccino – the slicer springs into action and shows me just the 
Cappuccino rows.

12.3.4	 Add another slicer

Figure 426 – you can have more than one slicer

Follow the same steps to add a slicer, only this time select a different field.

In the image above I now have one slicer for the Item column and one for the Centre.
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12.3.5	 Filter on a second field

Figure 427 – keep on refining the filter field by field

Simply click on the field on which you want to filter.

In the image above, I have applied two filters, one on the Item field and one on the Centre field – so 
now I am looking at the sales of Cappuccino in Leeds only.

12.3.6	 Remove the filter applied via slicer

Figure 428 – clear the slicer – click the little red x

Click the red x next to the Filter icon at the top of the slicer.
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12.4	 Customize a slicer

If you have more than one slicer you might want to change the colour of the second one to make it 
easier to differentiate.

12.4.1	 Format a slicer

Figure 429 – change the colour of a slicer

1.	 Click on the slicer to select it
2.	 Click on the style you want to apply from the Slicer Styles gallery 

Figure 430 – two slicers in different colours

12.5	 Delete a slicer

12.5.1	 To delete a slicer

Click on the slicer and press the Delete Key on the keyboard.

The slicer will be gone!
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13	 Grouping and outlining
13.1	 Outlining

If you have a spreadsheet with totals of certain groups of data you can outline those groups so that you 
can expand and collapse them. You need to have some subtotals applied, and in the following chapter 
we will see how to get Excel to apply subtotals automatically. 

My data assumes that totals have already been generated.

13.1.1	 Data with totals

Figure 431 – group some or all of the data

Here are some of the rows of data for Coffee Island sales. I have totals for the sales of each centre showing 
here. If I group the data I can collapse it and see just the outlines.
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13.1.2	 Group data

Figure 432 – select what you want to group first

1.	 Select the data to group – in this case A2:H7
2.	 Click on the Data Ribbon Tab
3.	 Click on the drop down under Group
4.	 Select Rows or Columns (in my example Rows)
5.	 Click OK

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 
© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

http://bookboon.com/
http://bookboon.com/count/advert/0ba6aa54-2f19-4d35-9ee1-a00400a7e3c6


Download free eBooks at bookboon.com

Excel 2013 Core: Advanced

124 

Grouping and outlining

Continue to create groups for each set of data.

Figure 433 – more than one group

Here is my data with an outline that I created manually. I grouped each set of data.

I now have the small 1 and 2 icons at the top left of the screen (1)

Also note the lines and the minus signs in the new grey margin (2)

13.1.3	 View the totals

Figure 434 – collapse to see totals

Click on the 1 in the top left corner and the groups will collapse so that you can see just the total rows.
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13.1.4	 View a particular set of data

Figure 435 – expand a particular set of data

To expand a particular set of data, and see how it is made up, click the plus sign next to the total.

Here you can see all the rows that belong to the Bath group.

13.1.5	 Remove an Outline

Figure 436 – clear the outline here

1.	 Click inside the data
2.	 Click on Un-group
3.	 Select Clear Outline
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13.2	 Create an automatic outline

You can make Excel create an outline automatically for you too.

13.2.1	 Auto outline

Figure 437 – Excel will create an automatic outline

1.	 Click inside your data
2.	 Click on the drop down under Group
3.	 Click on Auto Outline

Your data will now have two outlines, one for rows and one for columns.

13.2.3	 Auto Outline Groups

Figure 438

In my Auto Outlined data I now have more of the small icons in the top left of the spreadsheet, one set 
is for the rows, and one for the columns. (1)

I also have a minus icon on the far right – I can collapse the columns here and Excel will hide all the 
columns except the Sales column which makes it easier to read (2)

I also have the plus signs in the left margin to expand and collapse the groups. (3)
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14	 Subtotals
14.1	 Why use subtotals?

Subtotals are one of my all-time favorite features in Excel and have been around for quite a while. I am 
always amazed at how many people have no idea how useful they are. 

In the section on grouping and outlining data, see page 120, we wanted to see totals for certain groups 
of data. To do this we had to use the following process:

•	 Sort the data by the item on which you want to group
•	 At the end of each group of data add a row
•	 In each of the new rows, type the text to describe what it is
•	 In the column we want totals for, create the Sum on the total row
•	 Then add the grouping and outlining.

Phew! So much work!
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The Subtotals Command does ALL of that automatically with one exception – you have to sort the data 
first. Excel is very clever and sometimes seems like magic, however it cannot read your mind. So if you 
want to summarize the types of drink sold you first need to sort the data on that column. Do you want 
to see subtotals for the centre where the drinks were sold? Sort on that column.

The data does need to be arranged in columns with repeating data so that it can be summarized. In my 
Coffee Island Sales worksheet, I can summarize by item, centre or area. All I have to do is sort it first!

14.2	 Sort first

Sort the data by the column you want to summarize.

14.2.1	 Sort

Figure 439 – sort the data

1.	 Click into the column to sort by (1)
2.	 Click on the Data Ribbon Tab
3.	 Click the Sort AZ to sort alphabetically (2)
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14.2.2	 Data sorted by item

Figure 440 – Sorted data

14.3	 Subtotals command

Now that the data is sorted, I want to add subtotals to each group of Items.

14.3.1	 Insert iubtotals

Figure 441 – Subtotals on the Data Ribbon

1.	 Click inside the data list – this is very important, if you don’t Excel does not find any headings.
2.	 Click on Subtotal
3.	 Then Complete the dialog box
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14.3.2	 Subtotal dialog box

Figure 442 – set the criteria here

1.	 Change the – At each change in to the field name you want to summarize by – in my case Item
2.	 Choose the function you want to use – I have selected Sum
3.	 Tick the box for the column you want to summarize – I have ticked the Sales column, you 

may have more than one column to summarize just tick all the boxes
4.	 Click OK

What about the other options in the dialog box?

Replace current subtotals – I used the Sum function to total the sales of each type of Item. However I 
might want to add an Average Sales. If I leave Replace current subtotals ticked, the Sum will be removed 
and the Average function will replace it. If I would like to see both the Sum and the Average, I need to 
uptick that box.

Page Break between groups – when printing your subtotals you might want each different group to 
print on a separate page, tick this box to do that.

Summary below data – this makes sure that the summary row is below the group of data – best to 
leave this ticked.
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14.3.3	 Grand total

Figure 443 – see the grand total only

Click the Number 1 in the top left corner to see just the grand total which Excel added to the data.

14.3.4	 Subtotals

Figure 444 – see just the subtotals

Click the Number 2 in the top left corner to see all the subtotals and the grand total
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14.3.5	 See all data

Figure 445 – see all data

Click the Number 3 in the top left corner to see all the data.

14.4	 Remove subtotals

When you have finished working with subtotals or if you want to see the data totaled by different 
columns, remove the current subtotals. The data returns to a list and you are now free to re-sort it or 
get on with something else.

14.4.1	 Remove subtotals

Figure 446 – remove when finished

1.	 Click inside the data – if you don’t Excel will not recognize the subtotals and will not be able 
to remove them

2.	 Click on Subtotals
3.	 Click on Remove All
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15	 Apply conditional formatting
15.1	 Conditional formatting

Conditional formatting is another one of those really handy tools. Format your data so that you can 
highlight all entries over a certain value, or below a certain value. Use fancy formatting to show data 
that matches your criteria. There are several types of Conditional Formatting to choose from. 

•	 Highlight Cells Rules – pick this to show cells that match a particular number/text value/date.
•	 Top/Bottom Rules – pick this one, for example, to find the Top 10, Top 10%, Bottom 10 or 

Bottom 10%.
•	 Data Bars – these shade the cells based on top and bottom values, so the greater the value 

the more shading in the cell. You can pick the colour scheme to suit.
•	 Colour Scales – use Colour Scales to apply a scale from smallest to largest and set what 

each colour means.
•	 Icon Sets – Use Icon Sets to show crosses and ticks, traffic lights etc as symbols in the 

highlighted cells.
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15.1.1	 Highlight cells rules

Figure 447 – apply a rule to highlight cells

1.	 Select the cells to which you want to apply the formatting
2.	 Click on Conditional Formatting
3.	 Click on Highlight Cells Rules
4.	 Choose Greater Than 

15.1.2	 Add the criteria

Figure 448 – what criteria should it highlight?

1.	 Type in the criteria you want to match – in my example I am looking for cells where the 
value is greater than 500

2.	 Pick one of the formats – I have left it at the default format of Light Red Fill with Dark Red 
Text (you can pick a different one or create a custom format)

3.	 Click OK
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15.1.3	 Remove conditional formatting

Figure 449 – clear conditional formatting when done

1.	 Highlight the cells with the formatting
2.	 Click Conditional Formatting
3.	 Select Clear Rules
4.	 Make a choice of Clear Rules from Selected Cells or Clear Rules from Entire Sheet

15.2	 Top and bottom rules

Figure 450 – top 10, bottom 10 etc

1.	 Select the cells
2.	 Click Conditional Formatting
3.	 Click on Top/Bottom Rules
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15.2.1	 Add/pick criteria

Figure 451 – set criteria

I picked Top 10 Items
Click OK

Figure 452 – top 10 values formatted

In this case, the Top 10 values have been formatted.

Try out the other options in the list and see what results you get.
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15.3	 Data bars

Data bars will shade the cells according to their values.

15.3.1	 Apply data bars

Figure 453 – data bars fill the cells with colour

1.	 Select the cells you want to use
2.	 Click Conditional Formatting
3.	 Click Data Bars
4.	 Select the colour scheme to suit

You will see the colour applied to the selected cells.
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15.3.2	 Remove conditional formatting

1.	 Select the cells with the formatting
2.	 Click Conditional Formatting
3.	 Click Clear Rules
4.	 Select Clear from Selected Cells or Clear from Entire Sheet

15.4	 Colour scales

Colour scales apply shading to cells using a predefined scale of colour from hot to cold or within a 
colour palette. 

15.4.1	 Apply colour scales

Figure 454 – colour scales are great for presentations

1.	 Select the data to which you want to apply the format
2.	 Click Conditional Formatting
3.	 Click Colour Scales
4.	 Select the colour scale you want to use

The format will be applied.
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15.4.2	 Remove conditional formatting

Figure 455 – clear conditional formats

1.	 Select the cells from which you want to remove Conditional Formatting
2.	 Click Conditional Formatting
3.	 Click on Clear Rules
4.	 Choose whether to Clear Rules from Selected Cells or Clear Rules from Entire Sheet
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15.5	 Icon sets

Icon sets can be used to really jazz up your data. Use them when you need to show a visual image – 
useful when the data is added to a presentation.

15.5.1	 Apply icon sets

Figure 456 – icon sets add fun to a dull spreadsheet

1.	 Select the data to which you want to apply Conditional Formatting
2.	 Click Conditional Formatting
3.	 Click on Icon Sets
4.	 Pick the Icon Set you want to use

You may notice hash symbols in some of the cells – the reason for this is that the column is not wide 
enough to display both the values and the icon. To rectify simply re size the column width.

15.5.2	 Show the icon only

There may be times such as when adding the data to a presentation, or showing it to your boss, that you 
want to hide the numbers and just show the icons.

In order to do this, you will need to edit the rule.
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15.5.3	 Edit the rule

Figure 457 – edit the rule here

1.	 Select the data with the rule applied
2.	 Click Conditional Formatting
3.	 Click Manage Rules (near the bottom)
4.	 In the dialog box click on the rule you want to Edit (1)
5.	 Click Edit Rule (2)

 

  

 

                . 
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15.5.4	 Edit formatting rule dialog box

Figure 458 – change elements of the rule

This is where you can change different elements of the rule such as changing the icons used or how 
they work.

1.	 For our purposes – check the box Show Icon Only 
2.	 Click OK
3.	 Then click OK again

Figure 459 – here are my icons

Back in the spreadsheet the data has gone and only the icons are showing.
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15.5.5	 Remove conditional formatting

Figure 460 – clear conditional formatting

1.	 Select the data with the formatting
2.	 Click on Conditional Formatting
3.	 Click on Clear Rules
4.	 Choose from Clear Rules from Selected Cells or Clear Rules from Entire Sheet
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15.6	 Clear rules

When you have finished presenting your data, you may want to remove the conditional formatting. 
Here is how.

15.6.1	 Remove conditional formatting

Figure 461 – clear rules from selection or entire sheet

1.	 Select the data with the formatting
2.	 Click on Conditional Formatting
3.	 Click on Clear Rules
4.	 Choose from Clear Rules from Selected Cells or Clear Rules from Entire Sheet

15.7	 Use a formula to control conditional formatting

To add conditional formatting to show a range of colours – where a cell has a value greater than 100% 
turn it green, where it has a value less than 90% it is red and if in between it is amber.

15.7.1	 Change the colour fill

Figure 462 – use a formula in conditional formatting

Here I apply the conditional format to the cells in column B. I tell them to look at the cell in column C 
and depending on the percentage shown, the colour will change.
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I apply three formats to the cells one on top of the other.

=$C1>=1 – if C1 is greater than or equal to 1 the format goes Green
=$C1>0.9 if C1 is greater than 0.9 the format is amber
=$C1<0.9 if C1 is less than 0.9 then the format goes red

15.7.2	 Apply the first condition

Figure 463 – set first condition

Select the cells to which you want to apply the conditional formatting and then click on Conditional 
Formatting and select Manage Rules.

15.7.3	 Add a rule

Figure 464 – add a rule

1.	 Click New Rule 
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15.7.4	 Use a formula

Figure 465 – set the formula

2.	 Type in the formula you want to use in this case 
3.	 Format the values where this formula is true – C1 is greater than or equal to 1 
4.	 Click the format button (1) and set the format of the cell to a fill of green

15.7.5	 Format the cell

Figure 466 – choose the formatting

1.	 Click on Fill
2.	 Select the colour
3.	 Click OK

15.7.6	 Repeat for the other conditions

Go back and add the other two rules to the selected cells.

Remember when creating the rules to make sure that only the column reference is fixed, otherwise as 
you copy the format down the column, it will not work correctly.
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16	 Sparkline charts
16.1	 Sparkline line chart

Spark lines are small charts of the data that are displayed in one cell. They print with the worksheet so 
they are always visible. Spark lines can help you see a picture of how your data is performing.

I have a spreadsheet with Average Temperatures for the UK in each month for the years 2001 to 2013. 
I now want to see some charts to give me a visual of the numbers.

16.1.1	 Data without spark lines

Figure 467 – data without sparklines

I am going to add the spark lines in a new column in between the month and the first column of numbers. 
So the first job is to insert a new column between Column A and Column B.
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16.1.2	 Create a line spark line

Figure 468 – create a spark line

I have added the empty column and it is the new Column B.

1.	 Select the data that will be shown in the spark lines
2.	 Click on the Insert Ribbon Tab
3.	 In the Spark Lines Group click on the type of spark line you want to create – in this example 

I will select Line
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16.1.3	 Select the location for the spark lines

Figure 469 – set location for the sparkline

1.	 In the dialog box that pops up, confirm that the data range is correct – it should be as you 
selected it! (1)

2.	 Then select the range of cells where the spark lines will be placed. You can click the small 
box to the right of the Location Range (2) to collapse the box and enable you to select on 
the spreadsheet.

3.	 Click OK

16.1.4	 Spark lines appear

Figure 470 – sparklines appear!

Here you can see the spark lines in Column B. 

It is possible to edit the spark lines to make them a different colour, show High, Low, First, Last Points 
and set the marker colour.
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16.1.5	 Change spark line style

Figure 471 – change the style

1.	 Click into the spark lines on the spreadsheet
2.	 Select a different style from the Style Box

16.1.6	 Show markers on spark lines

Figure 472 – add markers

To show markers, tick the boxes in the Show Group for the markers you want to see, a sample will be 
shown in the Style Group so you can see what it looks like.
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16.1.7	 Edit markers

Figure 473 – edit the markers

To change the colour of the markers so that they show up on the spark line easily:

1.	 Click on Marker Colour
2.	 Select the Marker to change
3.	 Choose a colour

16.2	 Column spark lines

Here is the same data with column spark lines instead of line. Create them exactly the same way, just 
click on olumn Spark line.

16.2.1	 Column spark line

Figure 474 – sparklines as columns

Edit the column spark line in exactly the same way as the line spark line.
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16.3	 Creating a win/loss spark line chart

Setting up a win/loss spark line is a little different. The data sets upon which it is based consist of -1, 1, 
and 0 for no line. So your first job is to set up the data.

I have picked July and August temperatures and put a -1 in the cell where one month was lower and 
a 1 in the cell in which the corresponding month was higher. So in 2001 July had a lower average 
temperature than August.

16.3.1	 Data for win/loss spark line

Figure 475 – set the data first

Negative numbers signify a loss and positive numbers a win. If you don’t want to show anything for a 
particular column put a 0 in there.

16.3.2	 Win/loss spartkline

Figure 476 – win loss sparklines are a bit different

The steps are the same:

1.	 Select the data for the Spark Line Chart
2.	 Click on the Insert Ribbon Tab
3.	 Click on Win/Loss Spark Line Icon
4.	 Complete the dialog box including where you want the spark lines to be placed
5.	 Click OK
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16.3.3	 Spark lines appear

Figure 477 – here they are

In this image, positive numbers are showing up in Blue and negative in Red

16.4	 Remove a spark line chart

You may want to remove the spark lines from your spreadsheet once they have served their purpose. 

16.4.1	 Remove a spark line

Figure 478 – clear a sparkline

1.	 Click in to the cells where the spark lines appear
2.	 Click on Clear 
3.	 Make your selection based on whether you are removing a single spark line or a whole group. 
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17	 Text functions
17.1	 Text functions – an introduction

Text functions in Excel allow you to change the formatting of text, join text up, split text down and lots 
of other things. In this chapter are some of the text functions that are particularly useful when working 
with data.

Imagine you have imported data to Excel from another source and it has come in with leading or trailing 
spaces, use the trim function to remove them.

You have a volunteer at your organization whose job it is to input names and addresses from a written 
list into a spreadsheet. They forget to use a first capital letter on the name field, use Proper to rectify this. 

If the Post Code should all be in UPPER CASE and has been typed in lower case or a MiXture – you 
can use UPPER to make all text in Upper Case and the Lower function will turn text written in UPPER 
case to lowercase.

The Mid, Left and Right Functions, allow you to pull out a specified number of characters from a text 
entry from the left, the right or the middle of the text.
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Working with a database, you may have a First Name field and a Last Name field, however when writing 
to your list or creating labels for an event, you require a Full Name field. Use the Concatenate Function 
to join two fields together.

17.2	 Concatenate

If you keep your contact list in an Excel spreadsheet you may well have it listed in columns such as First 
Name Surname etc. You really need a column called FullName and Excel can populate this for you using 
the Concatenate function.

17.2.1	 Data ready to join up

Figure 479 – set the column up first

I have added the FullName field to Column C

Figure 480 – start the function

As this is a function:

1.	 Type an = sign 
2.	 Start to type Concatenate – Excel will pop up a helpful tip on screen, double click with the 

mouse over Concatenate (it save typing it all in !)
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17.2.2	 Build the function

Figure 481 – build the function

Inside the brackets you must add instructions to tell Excel what to do.

1.	 Click on the first cell to add – this is the First Name cell A2
2.	 Then type an & – this tells Excel we are going to add something to cell A2
3.	 Now I really want a space in between the First Name and Last Name so I have to let Excel 

know this – type “space bar” a space surrounded by double quotation marks. Whenever text 
goes inside a formula like this it goes inside double quotation marks.

4.	 Then type another & – to add something else
5.	 Finally click on the second cell reference -B2 in this example
6.	 Close the brackets
7.	 Press Enter

This is what you see in the formula bar =CONCATENATE(A2&” “&B2) 

Next you can use auto fill to copy it to the rest of the cells in the column

17.2.3	 Copy to the rest of the cells

Figure 482 – copy it down

Now I have a full list of FullName.
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17.3	 Trim

Remove leading or trailing spaces.

17.3.1	 Data with leading and trailing spaces

Figure 483 – data all wrong

In this list you can clearly see that there are some leading spaces and if I were to sort this list anything 
with a leading space would be at the top of the list so not a good sort.
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17.3.2	 Trim function

Figure 484 – type in the formula

1.	 In the column next to the one to trim
2.	 Type an = sign
3.	 Then start to type Trim – a label will pop up which you can double click to select
4.	 Click on the cell to trim – in this case A2
5.	 Press Enter

17.3.3	 Copy to the rest of the column

Figure 485 – copy down

You can now use auto fill to copy this formula to the rest of the cells. Note that the leading spaces have 
gone and everything lines up.

However there is one more step to make sure that the data is nice and clean. I want to remove the formula 
and keep just the results. I will use Paste Special to do this.
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Figure 486 – Paste Special to the rescue

1.	 Select all the cells
2.	 Right click and Copy
3.	 Then Click into the first cell where you would like the results to show up
4.	 Right Click and choose Values from the Paste Options – this pastes the result not the formula
5.	 Press Enter. As the whole range was selected all the values are pasted.

You can now cut and paste the values into the original cells keeping the data nice and clean.

17.4	 Upper

Upper case converts text to Upper Case. Simple!

17.4.1	 The upper function

Figure 487 – convert text to Upper Case

1.	 Click into the cell which will hold the changed text
2.	 Type an = sign
3.	 Type Upper
4.	 In the brackets click on the cell with the wrongly formatted text
5.	 Press Enter

See your text change to upper case. Now use auto fill to copy to the rest of the cells.
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17.5	 Lower

Lower case is handy if you forget to turn off the Caps Lock key. It turns all text to Lower Case.

17.5.1	 Lower function

Figure 488 – convert text to lower case

1.	 Click into the cell to hold the newly formatted text
2.	 Type an = sign
3.	 Type Lower
4.	 Inside the brackets click on the cell to change (C2 in my example)
5.	 Press Enter

Now use auto fill to copy it to the rest of the cells in the range.
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17.6	 Proper

If you left the Caps Lock key on, and want to reformat text to have an initial capital letter, then use 
Proper. It works on all lowercase too.

17.6.1	 Proper function

Figure 489 – convert to first capital letter

1.	 Click into the cell to hold the newly formatted text
2.	 Type an = sign
3.	 Type Proper
4.	 Inside the brackets click on the cell to change (E2 in my example)
5.	 Press Enter

Now use auto fill to copy it to the rest of the cells in the range.

17.7	 Right

The Right function allows you to pick up and extract as many characters from the right of a cell as you 
specify. So if you want to extract the last 4 letters, it would be =Right(A2,4)

17.7.1	 Right funtion

Figure 490 – pick characters from the right

1.	 Click into the cell where you want the answer to display
2.	 Type an = sign
3.	 Type Right (
4.	 Click on the cell to extract from (G2 in this example)
5.	 Type a , (comma)
6.	 Type the number of characters to extract (in our case 4)
7.	 Press Enter
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17.8	 Left

The Left function allows you to extract a number of characters that you specify from a cell.

17.8.1	 Left function

Figure 491 – extract number of characters from the left

1.	 Click into the cell where you want the answer to display
2.	 Type an = sign
3.	 Type Left (
4.	 Click on the cell to extract from (G2 in this example)
5.	 Type a , (comma)
6.	 Type the number of characters to extract (in our case 4)
7.	 Press Rnter
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17.9	 Mid

The Mid function picks up a number of characters that you specify from the middle of a cell. You tell 
the function where to start from and how many characters you want to extract.

17.9.1	 Mid

Figure 492 – extract from the middle

1.	 Click into the cell where you want the answer to display
2.	 Type =Mid(
3.	 Click on the Cell you want to extract from (C2)
4.	 Type a comma
5.	 Type where Excel should start from (in this example from the second character)
6.	 Type a comma
7.	 Type the number of characters to extract (3 in our case)
8.	 Press Enter
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18	 Quick analysis
18.1	 Quick analysis

Quick analysis is a new feature in Excel 2013. Quick analysis looks at the data you have selected and 
offers you various options to analyze and summarize the data. Once you get used to using it, you will 
wonder what you did before!

Figure 493 – various quick analysis options

There are five main types of analysis and within each type you will be offered more options.

Formatting – here you can find various conditional formats – Excel will guess which are best suited to 
the data selected
Charts – A selection of charts will be suggested
Totals – Various calculations 
Tables – A selection of tables will be found here
Spark lines – Excel will offer you spark lines to be added to adjacent cells
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18.2	 Quick analysis Formatting

18.2.1	 Formatting

Figure 494 – format data quickly

1.	 Click the Quick Analysis Smart Tag
2.	 Click on Formatting
3.	 Choose from the formats offered – Excel will preview the chosen format on the selected 

data so you can flip between them before making a decision
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18.3	 Quick analysis totals

With the totals quick analysis you are offered a selection of functions that can be performed on the data. 
Choose whether to add them underneath the data or in a column to the right

Figure 495 – quick summaries

1.	 Select the data
2.	 Click the Quick Analysis Smart Tag
3.	 Click on Totals
4.	 Choose the type of total you want to add – Here I selected a Sum note that Excel added a 

total row to the data with the word Sum and also added the formula to the data
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18.4	 Quick analysis Charts

Figure 496 – charts are offered too

1.	 Select the data
2.	 Click on the Quick Analysis Smart Tag
3.	 Click on Charts
4.	 Hover over the different charts to see a preview of how they will look – to select one click 

on it
5.	 The chart is then placed on the spreadsheet – see below

Figure 497 – chart
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18.5	 Quick analysis Tables

Instead of selecting the data and choosing Format as Table from the Home Ribbon you can use quick 
analysis to get a standard table or a quick pivot table

Figure 498 – quick tables

1.	 Select the data
2.	 Click the Quick Analysis Smart Tag
3.	 Click on Tables
4.	 Click Table and a preview will be placed over the data – click to insert

If you choose Blank Pivot Table, you will find a new blank pivot table inserted on a new worksheet ready 
for you to build
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18.6	 Quick analysis sparklines

Get Excel to add spark lines directly from the Quick Analysis Smart Tag

Figure 499 – quick sparklines

1.	 Select the data
2.	 Click the Quick Analysis Smart Tag
3.	 Click on Spark lines
4.	 Choose the spark line that you want to use 
5.	 Spark lines will be added to the adjacent column
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19	 Macros
19.1	 What is a Mmcro

A macro is a recording of a series of tasks. Usually repetitive things that can take time and follow the 
same sequence of events. By recording them into a macro the whole sequence can be performed at the 
click of a button. For example if you always want to change the spreadsheet to landscape and print three 
copies – record a macro add it to a button and hey presto just play it back each time.

19.1.1	 Developer ribbon

Figure 500 – Developer Ribbon

In order to record a Macro you must display the Developer Ribbon if it is not already showing. 

To do so:

1.	 Click the File Menu
2.	 Click Options
3.	 Click customize the Ribbon
4.	 Place a tick next to the Developer Ribbon
5.	 Click OK
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19.2	 Macro security

There is one other thing you must check before you get started with macros and that is the Macro 
Security. You must let Excel know that you are willing to work with macros.

As macros can potentially run malicious code, you must let Excel know that you would like to run them 
but you want a little warning to pop up and check in with you before you do.

19.2.1	 Enable Macro Security

Figure 501 – enable macro security

On the Developer Ribbon click on Macro Security in the Code Group

19.2.2	 Disable all macros with notification

Figure 502 – make sure to set Disable with Notification set

Make sure that the Macro Settings show Disable all macros with notification – this means that Macros 
will not run unless you enable them. A notification will pop up and alert you.
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19.3	 Get ready

Now you are almost ready to record a macro. First of all though you need to decide where to store the 
Macro when it is recorded.

This Workbook (default):

Places the macro on a separate sheet called a module behind the scenes of the current workbook. Macros 
stored here will only be available when this workbook is open. The benefit of storing the macro in the 
current workbook is that it will be available to anyone who has access to the workbook, whether shared 
or sent to them.

New Workbook:

Opens another workbook and puts the macro there (sometimes used when testing out bits of a 
macro’s code).

Personal Macro workbook:

Creates a special hidden workbook that opens whenever Excel is run on your local machine. The macros 
stored here are available whenever you use Excel regardless of which workbook you are in. If you store 
your macros here, they will not be available to others if you share a workbook. You will need to add the 
macro to the workbook you are sharing in order for it to be available to others.

Having decided where to store it, it is a good idea to practice the steps you are going to record – in fact 
it is quite a good idea to write them down. As you start recording, the Macro Recorder notes every move 
you make and also the time it takes – it simply records everything. You want to record the macro with 
as little fuss as possible. If you make a mistake and correct it, the recorder records that too!

So for my previous example of printing the spreadsheet landscape and three copies the steps go like this.

Switch to landscape – press Alt + P + o and down arrow and Enter to change to landscape
Press Control + P
Tab into the number of copies and type 3 
Press Enter to print

When testing out you will end up printing and then again when you record the macro. That is because 
we have to perform the steps in order to record them.

You will note that I used the keyboard to create the macro not the mouse. That’s because the Macro 
Recorder records the keyboard moves.
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19.3.1	 Relative or absolute referencing

Figure 503 – relative or absolute

Relative References – this means that the macro will perform the actions you record in relation to the 
starting cell.

Absolute References – this means that the macro will record starting from the same cell every time.

Let’s say that you are recording a macro to reformat a spreadsheet. You need to cut information from 
one place, paste it into another and then repeat the process down several rows. If you record this with 
Absolute References switched on the macro will record over itself the whole time – if you programmed 
it to begin in A3 then it will return to A3 each time.

If however you program it with Relative Reference on – then it will work relative to the cell in which 
your cursor is when you start the macro each time.
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19.4	 Get set and go

Here we go to record the macro just mentioned.

19.4.1	 Record Macro

Figure 504 – record a macro

1.	 Click Record Macro in the Code Group
2.	 Name the Macro – names must not have any spaces in them. Use capital letters or 

underscore characters to differentiate between words
3.	 Assign a keyboard shortcut 
4.	 Pick where to store the macro
5.	 Type a description – this is optional
6.	 Click OK to begin recording

19.4.2	 Finish recording

Figure 505 – stop recording

Once you have performed the sequence of steps for the macro click Stop Recording – this button said 
Record Macro earlier.
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19.5	 Run the macro

Now that you have recorded your macro you want to use it. When you created the macro you assigned 
a keyboard shortcut to it. Now all you have to do is press the keyboard shortcut. For the macro I just 
recorded the Keyboard Shortcut is Control + Shift + J.

You may however want to add the macro to a button on the Quick Access Toolbar. 

19.5.1	 Put the macro on The Quick Access Toolbar

Figure 506 – add a button to the Quick Access Toolbar

Click the drop down arrow on the right of the Quick Access Toolbar

Select More Commands

1.	 Change the Choose commands from to show macros
2.	 Click on the macro you want to add to the Quick Access Toolbar
3.	 Click Add
4.	 The macro is now on the Quick Access Toolbar
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19.5.2	 Modify the button

Figure 507 – modify the button

The icon for a macro is the same no matter how many you add so it makes sense to modify the button 
to something that you recognize.

1.	 Click Modify
2.	 Pick an icon
3.	 Change the text to display if required
4.	 Click OK
5.	 Click OK

19.5.3	 New macro button

Figure 508 – new macro button

Here is my new macro button – it has a happy face and the tooltip shows the name – 
Print3CopiesLandscape.
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